
Super tips to quick recap  Star office writer1=9;2=2;5=2 

File->new->text document To create /open a new 
document 

                                                         To move                                
Press 
One character to the left            LEFT ARROW 
One character to the right       RIGHT ARROW 
One cell to the left (in a table)       SHIFT+TAB 
One cell to the right (in a table)                 TAB 
Up one line                                      UP ARROW 
Down one line                           DOWN ARROW 
Up one screen (scrolling)                  PAGE UP 
Down one screen (scrolling)       PAGE DOWN 
To the end of a document              CTRL+END 
To the beginning of a documentCTRL+HOME           

Shift+F1 To display an extended help tip 

F1 To open the staroffice help 
where you can search for a 
help topic 

Ctrl+E 
to center text. 

Ctrl+L 
to left align text. 

Ctrl+R 
to right align text 

Ctrl+J 
to justify text. 

Ctrl+B 
to make text Bold. 

Ctrl+I 
 to make text Italic. 

Ctrl+U 
 to make text Underlined 

Alt+T To invoke menu  

Ctrl+F12 To  insert A table 

A hard return is inserted every time when Enter 
is pressed 

File->save or Ctrl+ S save 
Edit->cut or Ctrl+ X Move 
Edit->copy or Ctrl+ C Copy 
Edit->paste or Ctrl+ V Paste 
Flashing vertical bar Insertion point 
Thick horizontal line End-of-document 
How will you correct 
mistakes: Delete key-- 
 
                   Backspace- 

Delete the character to the 
Right  of the insertion point 
Delete the character to the 
Left of the insertion point 

Ctrl +Left arrow Move the insertion point  one 
word to Left 

Ctrl+ Right arrow Move the insertion point  one 
word to Right 

End Move the insertion point  to 
the end of a line 

Home To the beginning of a line 
Ctrl+ End To the end of the document 
Ctrl+ A Select entire document 
Type over mode Text to the right of insertion 

point disappears- Insert key 
Status bar Show the current mode 
Insert mode 
--------------------------------- 
8.5 inch × 11 inch 
 

Text to the right of insertion 
point moves to right            .   
default width of a page in 
default orientation 

ColumnSpace Equally 

RowSpace Equally 
Rows/Columns the 

Same Size 
Default left and right 

margins 
1.25 inches 

Default paper 
size[portrait] 

11inchesX8.5inches 

Default paper 
size[Landscape] 

8.5inchesX11inches 

Default top and 
bottom margins 

1 inch 

InsertFieldspage 
number 

inserting page number 

window - switch between multiple documents  
Text editing :entering a new text or modifying the existing 

text in a document 

EditSelect All entire table is 
selected 

TableDelete Table to delete the 
selected table. 

Table Delete Rows 

TableDeleteColumn
s. 

to delete row and 

column 

Table Insert Rows  

Table Insert 

Columns 

To insert row and 

column 

Table Insert Table to create a simple, 
default - style 
table 

Format-> page *Creating a Header&Footer 
*Page Style Dialog Box 
*To change theorientation 

or paper size 

Format Paragraph 
Indents & Spacing 

Paragraph dialog 
box 

2 Changing Margins Using Rulers- View Ruler 
1. Page Style Dialog Box      2.ruler 

Edit Find & Replace-ctrl+f  To Find and 
Replace Text 

Tools->Auto correct Creating AutoCorrect 
Entry 

word processing packages -
MS Word, Lotus AmiPro, Word 
Perfect, Word Star&Word Pro. 

Times Ne Roman- 
professional and 
business document 

Fajita- decorative font 72 points- to an inch 

Points -Size of the font Highlighting -attention to key 
ideas 

Font -set of characters in a certain style Do not match with a squiggly red line. 
Enter -key pressed to enter a hard return Cell -intersection of Row and Column 
Hanging indent -special kind of indent Border -cell by default includes 

www.nammakalvi.org



Bulleted list -list of points or topic in a document Merge cell -   combines two and columns 
Backspace -delete a misspelled word Table -a grid with a specified number of columns and rows 

not in dictionary -text area displays the misspelled word Ignore once -to skip the spelling change only for the 
current word 

Add -to include the word to the dictionary ignore all skip all occurrences of the misspell word 
Text only-only check box in the auto correct dialog box            two types of page orientation  

Portrait - document is more than the width[default page] 
Landscape: document will be more than the length Page style- to set the margin 

 Header -area at the top of the page 
Footer -area at the bottom  of the page 

Creating a Bulleted OR Numbering List  
*Select the text that to which bullets are to be added. 
*Click on the Bullets icon from the formatting tool bar. 
 * Format   Bullets  &  Numbering 

2. Click icon   to create a numbered or 
Bulleted list. 

Removing the Bullets or Numbers 
*select the bulleted list or numbered list. 
*click the bullets icon or numbered icon again. 

ex.     1. Tamil            *Tamil 
        2. English        *English 
        3. Maths           *Maths 

AutoCorrect Entry 
1.Tools->Auto correct command is clicked 
2.Auto correct dialog box will appear 
3.If need, click replace tab 
4.In the replaced text box ,type replaced 
5.In the with text box type the correct word(or) 

replacement word 
6.Click replace button to all the word as autocorrect entry    
7.Click OK to finish the task 

 Line spacing-The space between any two consecutive line.  

 The default line spacing is 1 (i.e.) single line spacing. 

 The line spacing may also be fractional. 
steps are used: 
1. Select the paragraphs that need to be changed. 

2. Select FormatParagraph. 
3. If necessary, click the Indents & Spacing tab. The Indents &Spacing tab 

dialog box as appear 
4. Click on the Line spacing drop-down list box, and select the required line 

spacing option. 
5. Click the OK button  
Word processing: The term word processing refers to the activity carried out using a computer and suitable 

software to create, view, edit, manipulate, transmit, store, retrieve and print documents. 

Check spelling while typing:* An automatic spell-check feature that can check for possible spelling mistakes 
even as the document is being typed.  

*This feature can be turned ON or OFF by clicking on the Auto Spell check icon.  
*select ToolsspellingAuto spell check. 

Spelling after the Document is Typed  : Tools Spelling ->Check is selected or  is clicked.  
*press F7 key to get the spell check dialog box 
*Not in dictionary text area displays the misspelled word and the Suggestions list displays any alternative 

spellings. 
Any of the following can be done: 
• To skip this occurrence but stop on the next one. Ignore Once button is clicked. To skip all occurrences of this 

word. Ignore All button is clicked. 
• To replace the word with one of the selected spellings, in the suggestions list that spelling is clicked, and Change 

button is clicked to change this occurrence and Change All button is clicked to replace all occurrences of the 
world. 

*Add button is clicked to add the word to the dictionary. 

      Selecting Text with Mouse 
1. Insertion point is moved to the start of the text to be 

selected. 
2. The left mouse button should be clicked, held down 
and dragged across the text to be selected. 
3. When the intended text is selected, the mouse 

button should be released. 

         Selecting Text with Keyboard 
1. Insertion point is moved to the start of the text to be 

selected. 
2. The Shift key is pressed down and the movement 
keys are used to highlight the required text. 

3. When Shift key is released, the text is selected. 

1. - Table Fixed     2. - Table Fixed, Proportional 3. - Table, Variable 4.   - Merge Cells 

5.  - Split Cells    6. - Optimize    7.  - Inserting Row       8.   - Inserting Column  

9.   - Delete Row 10.   - Delete Column 11.  - Borders12. - Line Style 13. - 
Border Colour  



Star office Calc   1=7;2=2;5=2   

           Menu command                       Details 

File ->save icon OR Ctrl+S 
save 

File ->exit    Quit/exit from star office 
Edit ->fill->down(or Left) To copy the content of a cell 
Edit –Fill->Series To generate series of data 
Format ->Column->Width To change the column Width 
Format ->Row ->Height To change the row height 

View Toolbar  

Insert Cell  
1. Insert Cells Down,       2. Insert Cells Right, 

3.InsertRows             4. Insert Columns icons. 

Edit ->delete contents To delete the content from selected cell or cell range 
Edit ->Delete cells  To delete the selected cells, entire rows or columns 
Insert ->picture ->from file To insert a picture 
Insert ->special characters To insert special characters like α β 

View ->toolbar->insert object  
1. Insert Chart Icon: data in the worksheet in from of charts 
2. Insert Formula Icon: performing calculations  
3. Insert Floating Frame Icon: generate a scrolling screen 
4. Insert Movie and Sound Icon: sound or video files into the current worksheet 
5. Insert OLE Object Icon: objects from other application into a worksheet  
6. Insert Applet Icon: Java programming language into the worksheet 

Insert ->chart To insert a  chart 
File -> print To print 
Format ->print ranges->edit or Ctrl+P To set print range to print a part 
Format ->print ranges->delete To remove the print range setting 
MM/DD/YY Date 
HH:MM:SS Time 
Range  Continues group of cell in a worksheet Eg:G1:G6 
File ->page preview  To preview a worksheet before print 
Cell pointer Indicates the active cell 

F2  
function key edit data in a cell 

$ (dollar) sign in front of row and column Ex: $C$4. Absolute cell referencing 
No $ (dollar) sign in front of row and column 
Ex: =C4+D4+E4+F4 

Relative cell reference 
 

Operator             Name                          Example 
&(And)             Text operator: And      “Star” & “Office” 
                                                         yields” Star Office”                                                                                        

Text operators 
 

:(Colon) Range A1:C108 
!(Exclamation point) Intersection SUM(A1:B6!B5:C12) 

Reference Operators 
 

Visi Calc first electronic spreadsheet                       Dan Bricklin and Bon Frankston in 1979 

The personal computer (PC) first appeared in 1975  
Lotus 1-2-3 database management and graphics Lotus Development Corporation in1982 
Excel    Microsoft corporation 

Quattro Pro  Borland International 

Improve Lotus Corporation 

Star office calc      Sun Microsystems 

Tab Move forward through cells 

Shift+Tab Move backward through cells 

256 columns and 32000 row Star Calc 
63columns 254 rows Visi Calc 

=, < ,> ,<=, >= , < > [Inequality] Comparative operators 
+, - , * ,   / ,  %  , and  ^ (Caret) Arithmetic Operators 



 
Date arithmetic*In spreadsheets, date calculations 
become very simple. Here you can add a number to a date 
and arrive at a new date, find the difference between two 
dates and use a wide variety of function and formats to 
get what you want. Ex: formula = first cell – second cell. 

the data present in the cell  
*the new data simply overwrite the old content of the 

cell. 
*Click on the formula bar with the mouse press, the F2 

function key or simply double click on the cell. 
*a vertical cursor appears on the formula bar. 
*move the cursor to the left arrow key or the 

backspace key and edit the data. 
Functions are predefined formulae that are available in 
Star Office Calc.F2 

 Insert -> Function Ex: SQRT 

Auto format sheet: The facility of star office calc helps 
to formats the worksheet with different predefined styles 
and colour  .  Format ->Auto format 

An electronic spreadsheet is a worksheet used in a 
computer to create and quickly perform “What if” 
analysis of interrelated columnar data in workspaces. 

Spread sheet applications. 
1. Payment of bills            2. Income tax calculations     
 3. Invoices or bills             4. Account Statements     
5. Inventory Control          6. Cost-Benefits Analysis       
7. Financial Accounting     8. Tender Evaluation        
9. Result analysis of students 
 

Generate the series:33.30,27,….3.select the range 

A1:A11 in the worksheet.Click onEdit Fill Series. 
Choose33 as your Start value,-3 as your Increment 
Linear as the Type,andDown as the Direction.click OK 
Advantages of using Electronics spreadsheet 
• Calculations are automated through the built-in 
mathematical, financial and statistical functions. 
• Accurate results to any desired level of decimal 
points are Possible 
• Worksheets can be quite big in size 
• Any part of the worksheet can be viewed or 
edited. 
• Worksheet can be saved and retrieved later. 
• Any part or whole of the worksheet can be printed 
in a desired format. 
• Worksheet data can be viewed in the form of 
graphs or charts 

Formatting option 1.   Bold icon        

2.  italics icon      3.   underline icon 

4.  Change Font icon. 

5.  size icon 6.   Font Colour icon. 

7.   Align Left, Align Center, Align 
Right and Justify icons. 

8.   Number Format: Currency icon 

9.  Number Format: Percent icon. 

10.   Number Format: Standard icon 

11.   Number Format: Add Decimal and 
Number Format: Delete Decimal icons. 

The  features available with spread sheet 
1. Any part or whole of the worksheet can be printed in a desired format. 
2. Worksheet data can be viewed in the form of graphs or charts 
3. Worksheet can be saved and retrieved later 
4. Date arithmetic is possible in spreadsheet software 
5. Inserting pictures and special characters are possible in a spreadsheet package 
6. Drawing is also possible 
7. The sound and movies can be inserted into a worksheet very easily  

 
 
 
 
 
 
 
 
 
 
 
 



DATABASE1=9;2=2;5=1 

File NewDatabase. Open Star Office Base 
Ctrl+w To close a  window 
Ctrl+o To open an existing database file 

DBMS- is a program, or collection of programs and retrieval from large 
databases 

Database Management 
Systems 

SQL-DBMS supports a language that is similar to a programming 
language 

structured query language 

 sorting on more than one field of a table at the same time Multiple sorting 
1.Table   2.Record    3.Field three components 

Manipulation of a Database 
1. Searching- a process to select a desired specific data from a database. 
2. Sorting - Sorting is the process of arranging the data in a table in some order. 
3. Merging - Merging is a process of joining data from two or more tables of the same or different 
databases. 
4. Performing Calculations on data- any kind of arithmetic calculations on the data stored in the 
database.   
 5. Filtering- Filter is a way of limiting the information that appears on screen.   
6. Editing the database- corrections on the existing data, deleting the existing data changing the 
format of the database, and so on., 
 7. Report Generation- You may generate any desired report, from the data of the database  

Database Types 
1. Flat – File database - A database file that consists of a single data table. Data that is stored, 
managed , and manipulated in spreadsheet  
2. Relational database- A relational structure represents a database made up of a set of related 

tables. The common field or fields are called the Keys. 
3. Hierarchical database- The hierarchical database structures were primarily used on Main Frame 

computers. In hierarchical databases, records are organized in a tree like structure by type. 
parent-child relationship 

 4. Network database- The Network database is very similar to the hierarchical structure except 
that any one record type can relate to any number of other record types.  

  5. Object-Oriented database- An Object Oriented database is a newer structure that has been 
generating a great deal of interest in recent years. It represents very different approach to the 
way data is treated by database developers and users. 

Tables, Queries, Forms and Reports. left pane is the <Database> pane 

 1. Sort Ascending icon.     2. Sort Descending icon.  
Sorting the Records 

Queries: are special views of the data in a table. [user-constructed Statements ]Unlike sort, the 

output from a query does not affect the original table. The result from a query is always stored 
separately and can be viewed at any time. 

1. Field selection        2. Sorting order 3. Search conditions   4. Detail or summary 5. 
Grouping-skip     6. Grouping conditions-skip 7. Aliases         8. Overview 

A report is printed information that is assembled by gathering data based on user supplied criteria. 
1. Field selection 2. Labeling Fields 3.Grouping 4. Sort options 5. Choose layout   6. Create 

report 

A form is simply a screen that displays the fields of a record in a well-spaced out manner. The 
appearance of a form can be customized to your liking. A form can be associated with a single 
table or with multiple tables. 1. Field selection 2. Set up a sub form   3. Add Sub form field   

 4. Get joined field 5. Arrange controlled 6. Set data entry 7. Apply Styles     8.set name 

A filter is also a type of query. It is also used to select and display records, which match a certain 
condition. The remaining records are hidden form the user. The difference between query and 
filters is that queries can be saved for later use. Two types of filters. They are AutoFilter and 
Standard Filter. 



AutoFilter icon is available on the toolbar. Click on this icon to display only the records, which 
match the value of the current field. 

Standard Filter. Filter used with a condition called Default Filter. The condition can be specified by 

clicking on the Standard Filter icon on the toolbar. 

Information: A set of processed data that convey the relationship between data considered. 

1. A database is a repository of collections of related data or facts. 
2. It arranges them in a specific structure. 

Data base. 
 

*The term data comes from the word datum, which means a fact. 
*The data is as fact about people, places or some entities.  
*In computers, data is simply the value assigned to a variable. 

Data 

data processing had been carried out by long hand effort, we call 
as manual data processing 

Manual data processing 

1. A key that uniquely identifies a record in a database table. 
2. In relational databases, a primary key can consist of one or more 

fields.3. It uniquely identifies an employee record. 

primary key 

 
 Advantages of the computerized data processing 
1. Once we collect and enter the data into a computer system, We can perform other operations with 

less manual labour. So, manpower is considerable saved. 

2. The chances of errors are less in computerized data processing. 

3. It is easy to edit the data including correction, changes and modifications. 

4. Computerized database is highly effective for searching, sorting and merging files and for other 

data manipulation activities. 

5. We can store large amount of the data and information in the computer storage medium, 
which is compact. Hence, we need not store bundles of paper records, thus saving space 

Insert a Calc Cell Range into a Text Document 
1. Open a Star Office Writer (text) document 
2. Open a Star Office Calc (spreadsheet) that contains the data. 
3. In the spreadsheet, select the cell range that you want to display as a table in the text document. 
4. Choose Edit  Copy. 
5. In the text document, choose Edit Paste special. 
6 In the Paste Special dialog, select DDE link, and then click OK. 
Text and objects between star office between star office application using drag and drop 
1. Open star office impress presentation 
2. Open the calc spreadsheet that contains the data that you want to copy 
3. In the spread sheet select the cell range that you want to copy 
4. Just drag and dropthe selected range in to the presentation(use Alt+Tab to open thepresentation window) 
Involved in data processing: Data Collection, Verification and Validation of data, and Report Generation. 
Three general categories of DBMS: 1. Entering data into the database. 2. Reordering records in the database.  
3. Obtaining subsets of the data 

20-various field types  
 1. Text [VARCHAR]    2. Text [VARCHAR_IGNORECASE]     3. Text (fix)      4. Number      5. Date / Time    
 6. Date     7. Time     8. Yes / No    9. Memo   10.Image    11. Decimal     12. Binary Field (Fixed)      13. Binary field           
 14. Integer     15.Tiny Integer     16. small Integer     17. Big Int     18. Float   19.Real     20.Double 
row record 
column Field 

  data base  are classified into ---categories 5 
the maximum characters that can be entered in the 
field 

length   

The two types of reports data processing-2 types 



Multimedia1=5;2=2 

MIDI Musical instrument digital interface .Synthesizer-sound cards.Year:1982-digital 
notes-small file size. Extension:-   .mid/.midi 

RealAudio/Real Video Real Network-1995.Data transfer-internet-streaming files even poor bandwidths. 
Extensions:  .rm or .ram 

AU Supported by popular software across different platform. Extensions:  .au 
AIFF Audio Interchange File Format-apple. Not supports platform. Extensions:  .aif 

or  .aiff 
SND Sound –Apple-as like AIFF. Extensions:  .snd 
WAVE IBM and Microsoft. Supported by all popular web browser. Extensions:  .wav 
MP3/MPEG Moving Pictures Experts Group. high quality and good compression. 

Extensions:  .mp3 or .mpga MPEG: Extensions:  .mpg or .mpeg 
AVI Audio Video Interleave. Microsoft-1992.common format on internet. 

Extensions:  .avi  
Window Media Format Microsoft. It requires additional component in non-windows 

computer.Extensions:  .wmv 
Quick Format Apple. it requires additional component in non-windows computer. Extensions:  

.mov 
Shockwave  Macromedia. It store multimedia components created using Flash. Extensions:  

.swf 
MMS Multimedia Messaging System, send and receive message over cell phone 
WBT/CBT Web Based Tutorial/ Computer Based Tutorial 
HTTP/HTML Hyper Text Transfer Protocol/Hyper Text Markup Language  
GIF Graphic interchange Format  . 8 bit , a perfect reproduction of images    
Multimedia 
 

It is a computer –based presentation technique that incorporates text, graphics, 
sound, animation and video elements. 

Vector graphics It helps in rendering the image effectively on the screen. 
Eg: vector graphics card.  

Attribute control Two: 1. Amplitude 2. Frequency   
Volume  Height of each crest in the wave. 
Frequency/pitch The distance between the crest of wave. 
Sampling  conversion of analog sound waves to a digital format   
Sound forge Sound editing programs. Special effects, such as echo, fade in, and fade out effects 
Animations: They are primarily used to illustrate or demonstrate an idea or a concept. They are based on 
drawings. Type: Two or three-dimensional animations. 
2-D animation: Two categories. 
Cell-based: It consists of multiple drawing, each a little different from the others. 
Object-based:  Slide or path animations are created by moving an object across a screen. Eg: A ball 

moving across the screen. computer games 
3-D animation :  3-step process 
Modeling:  Create the board shape and structure. 
Animating : Animate the model to definite their motion 
Rendering : Giving attributes(colors, texture)to objects 
Morphing  A technique by which you can blend two or more image to form a new images 
Warping  A technique of distorting a single image to represent something else. 
Video  Like sound, video is also recorded and played back as an analog signal 
Video elements Frame rate, image size, and color depth determine the size of the video files 
Murky  Colour depth less than 256 colours  
Jerky Frame rate less than 15 frame/sec 

 
 



 
 
 

Compression : (two types) 
It is technique by which a recurring set of information is identified and replaced by single piece of 

information. 
Lossless :Retain the exact image trough out the compression  
Lossy :Provide a higher ratio of compression but result in some loss of quality 
Any 4 popular multimedia formats: MPEG ,    AVI,    QUICK TIME FORMAT ,   SHOCK WAVE 

FORMAT 
Inline sound and video. 
*Sounds and video in multimedia applications can be played “inline” or by using a “helper”. 
 *How the sound or video is played depends on the HTML tags. 
* You can add inline sound to a web page by using the <bgsound> and the <img> tags. 
* A helper application, also called as a Plug-in, is a program that can be launched by the browser to “help” 

play sound or video. 
Plug –in? What is advantage? Application? 

 A helper application, also called as a Plug-in, is a program that can be launched by the browser to 
“help” play sound or video. 

 The advantage of using helper applications is that you can allow the viewer control some or all of the 
player settings.  

 Ex: the viewer can control the volume settings, in addition to letting him rewind, play, pause, and stop 
the sound or the video. 

 Helper applications can be launched using the <embed>,<applet>, or the <object> 3 tags. 
commercial multimedia content development software used in the multimedia content  
Flash, Dream weaver and Maya 
3D animated Films: Finding Nemo, Polar Express, Ice Age, Sindbad, Pandavas, and Hanuman. 
CBT\WBT [Web Based tutorials]:e-learning packages-2- are used to train and educate people world over. 
JPEG: Joint photographic experts group. Save images digital cameras, supports full color and 

produces relatively small file sizes. lossy format 
Interactive multimedia :actively participate instead of just sitting by as passive recipients of information 
Frequency is also called  pitch -The distance between the crests of the waves                  
Nx views :for storing simple graphic images with relatively few colors 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



PRESENTATION1=5;2=2 

first page of the presentation wizard is….3 
To send text outline into presentation select----- FileSendOutline to presentation                
to end a presentation before the end- Esc       To run a slide show- F5 
Format Styles and Formatting or F11 key. Open the Stylist either by choosing 
Shift+Ctrl+N or[File->New -> Templates and Documents] To open or create Templates and 

Documents 
Transfer each heading together with its accompanying paragraphs, select the 
 File  Send  Auto Abstract to Presentation command. 
Shift+Ctrl+v--- Paste special select multiple slides-- ctrl 

InsertPicture  FromFile or  icon 
Insert a Picture in a slide 

InsertMovie and Sound Insert a Movie in a slide 
Tools Media Player To open Media Player window 
Format Page Background 
1.Color 2.Gradient  3.Hatching  4.Bitmap Image. 

Changing Slide Background 

Format Slide Design To apply a new slide design 
Slide Show Custom Slide Shows To create a custom slide show 
Slide Show  Show/Hide Slide To hide a slide 

To show a hidden slide 
File Print or press Ctrl + P. To print 
Edit Navigator Move from slide to slide quickly. 
This page displays various options that allow you to add or  
Modify animation effects to elements of a slide. 

custom Animation 

Allows you to create and edit slide Normal view 
Allows you to reorder slides, edit slide titles and heading Outline view 
Allows you to add notes to the slides or view any existing 
 notes for the slide. Notes are typically used by a presenter 
 to add additional information to a slide 

Notes view 

Allows you to scale the slides so that several slides can fit  
into a page. This view is typically used when the  
presentation is to be printed and distributed as a handout 

Handouts view 

Allows you to view miniature images of all the slides in the 
 presentation. This view is also used to rearrange slides 

Slide Sorter view 

This page can be used to specify basic background  
information that needs to be included in all the slides example, you can 

insert a company logo 

Master Page 

This page displays the various layouts provided by  
Star Office Impress. You can choose a layout while creating a new slide 

Layouts 

1. This page displays various transition effects that can be  
attached to a slide along with other options that allow you to  
Control the transition of the slides. 

Slide Transition 

File ->  Export to open HTML export wizard 
Insert->slide Insert slide 
TO insert----Insertslide 
To delete----Right clickchoose delete slide or Select slidepress delete key. 
TO rename---slideRename slide. 
Rehearse timings for automatic slide changes. Star Office records the 

display time for each slide, so the next time you play the show with 
automatic slide changes, the timing will be as recorded 

Rehearse Timings 

Show Logo check box will displaymessage,“Created with StarOffice” during pause between each presentation 

 
 



 customize a presentation 
To create a custom slide show: 
• Choose Slide Show Custom Slide Shows and then click New. 
• show the Custom Slide shows dialog box. 
• Enter a name for your slide show in the Name box. 
• Under Existing Slides, select the slides you want to add to your slide show, and click the >> button. Hold 

down Shift to select a range of slides, or Ctrl to select multiple slides. 
• You can change the order of the slides in your custom slide show, by dragging and dropping the slides 

under Selected Slides. 
• Click Ok. 

 features of star office impress 

 Star Office Impress is the Star Office application that allows you create attractive and 
professional-looking presentations.  

 It provides various tools that allow you to save and modify presentations, print them as 
handouts, and view presentations as slide shows or HTML pages. 

Insert OLE Object: This is used to import objects from other application into a presentation.  
*example, Star Office spreadsheet, formulae, text and even Microsoft application objects can be inserted 

To record a show with rehearse timings: 
• Open a presentation, and switch to Normal View. 
• Start the show with the Rehearse Timings from Slide Show menu. 

 You see the first slide and a timer in the bottom left corner 
• When it is time to advance to the next slide, click the timer. 

 Continue for all slides in your presentation. 

Left pane of the presentation window: The Slides pane on the left displays a thumbnail image of the slide 
and allows you to rename, delete, or rearrange them. 

A presentation, you can include a variety of items such as text, audio, hand-drawn images and videos. 
 To play a movie or sound file in an Impress presentation 
1. Open the slide that contains the movie or sound file. 
2. Click the object icon for the movie or sound file on the slide. 
3. Click Play on the Media Playback toolbar 

The different icons in Media playback Toolbar? 

Play icon - Plays the current file.    Pause icon - Pauses or resumes the playback of the current file. 

 Stop icon - Stops the playback of the current file.    Repeat icon - Plays the file repeatedly. 

 Position slider - Moves to a different position in the file. 

 Mute icon - Turns sound off and on.      Volume slider - Adjusts the volume. 

 Zoom - Adjusts the size of the movie playback 

Advantage of helper application over inline application in star office impress 
Helper application: It allows the view control some or all of the player settings. 
The viewer can control the volume settings. 
Inline application: *It can be played automatically. 
*Whenever the web pages loads without giving the viewer any control 
performing calculation in presentation- Insert Formula         
Apply the colours to the HTML pages  Use browser colors   
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